Sankey Helper 1.1

An Excel macro for drawing Sankey diagrams

———————————————

written by

Gabor Doka, Zurich, Switzerland, doka@unite.ch

What is Sankey Helper?

Sankey Helper is a command macro sheet based on MSExcel 4.0 that draws Sankey diagrams from input/output data contained in an Excel worksheet. The diagram is in PICT format, which can be easily pasted into drawing tools. Sankey Helper draws the input and output flux arrows of Sankey diagrams with the exact corresponding width and joins them up with nice round joints (a rather tedious process in most drawing software).

Sankey Helper draws non-looping top-to-bottom Sankey diagrams. It helps to quickly build more complex Sankey diagrams (hence "Helper"). Sankey Helper creates a Sankey diagram complete with labels. 

What is a Sankey diagram?

Sankey diagrams are a means to graphically represent energy or mass flows in input/output-processes (eg. energy balances of power plants, mass balances of industrial processes or ecosystems etc.). The width of the input or output arrows is proportional to the represented energy or material flux.

[image: image1.wmf]A Sankey diagram

Sankey Helper is "Sankey-ware"

Sankey Helper can basically be used free of charge (see "Copyright, Conditions of Use and Distribution" below). However I'd be most interested to see, what is accomplished with Sankey Helper. So send me any nice PICTs (or GIFs, JPEGs et cetera) you created with the help of Sankey Helper (send to doka@unite.ch). They are welcome and enthusiastically applauded. Comments, complaints and suggestions are welcome as well.

What's new in version 1.1?

•
Added an override scaling factor in the data sheet, located in the 6th column of the first row (start) (idea by Steffen Deszpot)

I don't want to read this, just give me my diagram!

Well, nothing will come from nothing (Eric Idle). However, open both files 'Sankey Helper…' and 'sample data', select one of the colourful 'start' cells in 'sample data', choose "Run..." from the menu "Macro", select the macro 'Sankey Helper'!DrawSankey and hit return. Alternatively you can use the Macintosh keyboard shortcut Option + Command + 'H' ([image: image2.wmf] + [image: image3.wmf] + H). 

Toy around with the various numbers (at your own risk) and see how they change the appearance of the diagram. If you do this long enough, you will eventually find out what I tried to describe here. So see you back! :-)

What do I need to use Sankey Helper?

Sankey Helper is a command macro for MSExcel 4.0. It can be imported into higher versions of MSExcel. It runs fine on my Excel98 (8.0). The macro uses the Excel built-in macro commands for drawing lines and arcs. You need MSExcel to run Sankey Helper. I'm assuming you're familiar with MSExcel basics. In case you're not familiar with macros: you need to open Sankey Helper by double-clicking in the Finder or opening it from MSExcel to use it. 

The input/output data to be drawn must be contained in an Excel worksheet with a certain table format . The diagram drawn with Sankey Helper is a picture in PICT format. The picture can be manipulated in Excel or in drawing tools.

How do I start? Creating a formated data sheet

Firstly you need the data you want to display. That data needs to be on an Excel worksheet (called "data sheet" form now on). The Excel worksheet "sample data" with some simple examples is provided along with the macro. You need to bring your data into a specific table format for telling Sankey Helper how you want it to draw that data. Sankey Helper draws simple non-looping diagrams "flowing" from the top down like the above example. Most importantly you need to tell Sankey Helper whether an input or output flux is to be placed on the left side of the main flux or on the right side and in what sequence. 

The data sheet must have the following layout (see also the 'sample data' worksheet):

1st column
2nd column
3rd column
4th column
5th column
6th column

draw code
measure





compulsory
compulsory





...






Columns 3 through 6 are used for special drawing information, which will explained in later sections below. You need to keep those columns free for the moment, i.e. the cells in columns 3 to 6 should be empty.

1st column: Draw Codes

In the first column you specify the parts you want Sankey Helper to draw. The diagrams are drawn in a specific order cf. picture below: firstly the top input is drawn (1), followed by the left side from top down containing all the input and output fluxes of the left side of the diagram (2). Then the right side is drawn top down (3). The diagram is then closed with the final output flux at the bottom (4). 

[image: image4.wmf]
This sequence must be reflected in the data sheet. The draw code in the first column specifies, what part of the diagram you want Sankey helper to draw. It has the following general structure:

Draw code
Meaning
sequence
Drawing

start
The top input flux 
1:
[image: image5.wmf]

in

out

adv
Inputs and 

outputs on the left side,

advancing line
2:
[image: image6.wmf]  [image: image7.wmf]  [image: image8.wmf]

leftend
Marks the end of the left hand side and starts the right hand side



in

out

adv
Inputs and 

outputs on the right side,

advancing line
3:
[image: image9.wmf][image: image10.wmf] [image: image11.wmf]

rightend
Marks the end of the right hand side 



end
The bottom output flux 
4:
[image: image12.wmf]

The bold draw codes (start, leftend, rightend, end) must be in every data table and they must only be used once per diagram in the sequence shown above . You must use all these four draw codes. Even if you e.g. don't want any fluxes on the right side to appear, you nevertheless have to declare that, by putting an rightend draw code after the leftend code.

The draw codes in italic (in, out, adv ) can be repeated in any order as you please between the draw codes start and rightend. 

The draw code in  marks an input flux on either the left or right side. Similarly out  marks an output flux. If you want to put some space between the fluxes you can use the adv to draw an advancing vertical line downward. The input and output fluxes already contain an automatic advancing line of suitable length, so that immediately consecutive fluxes won't overlap and take up the same space.

The data sheet can contain empty rows ("Sankey Helper" will ignore them). However the sequence of the rows containing draw codes in the first column is crucial. The draw codes in  and out can also be omitted on either side of the diagram resulting in "left-flux-only"- or "right-flux-only"-diagrams, respectively.

2nd column: measure

In the 2nd column you specify the quantities of the parts of the diagram. These can be typed numbers, the results of formulas or even links from other worksheets. For the inputs and outputs (draw codes  in, out ) as well as for the start input ( start ) these are of course the widths of the drawn fluxes. The final output flux ( end ) may optionally contain a figure specifing the final output, but its width is determined anyway by all the other inputs and outputs in the diagram. Sankey Helper will alert you if it finds any discrepancies in the input/output balance and the final output figure on the data sheet. 

Only use positive values for the measures. A negative input won't be drawn as output! You can use negative figures only, and you'll get a mirror image of the standard top-down diagram: a bottom-up diagram. Don't mix positive and negative figures unless you want your diagram to compete with modern art ... actually worth a try ;-). 

For the advancing line (adv ) the measure defines not a horizontal width of a flux, but the desired downward length of the line.

The draw codes leftend and rightend, finally, don't require to be given any data.

So, a basic data sheet for a simple Sankey diagram would be:

[image: image13.wmf]
This diagram starts with an top-in flux of 50 units. Two input fluxes of 20 on the left side and of 10 on the right side are added.

How do I get a diagram?

Have the macro sheet "Sankey Helper" open. In the data sheet select the cell in the top left cell of the data table where the draw code "start" should be. Note: you don't need to select the whole data range like usually necessary when drawing an MSExcel chart.

From the menu "Macro" choose "Run..." and select the macro 'Sankey Helper'!DrawSankey and hit return. Alternatively you can use the Macintosh keyboard shortcut Option + Command + 'H' ([image: image14.wmf] + [image: image15.wmf] + H). It is crucial that when running the macro the activated or front sheet is the data sheet. After a moment you will get a new worksheet containing the drawn Sankey diagram (it is a worksheet all right, but all cells and borders are white).

The simple data sheet shown above will result in something like the following Sankey diagram:

[image: image16.wmf]
Ugly, isn't it? :-)

You can see now the use of the advancing lines (adv draw code), which allows make the Sankey diagram better proportioned. Just insert an additional row in the data table:

[image: image17.wmf]
Select the "start"-cell on the data sheet and run the macro again. This results in a much nicer, better-proportioned diagram:

 [image: image18.wmf]
You might want to add labels to each arrow. Well, Sankey Helper can do that for you too. Just fill out the 3rd column of the data sheet:
3rd column: Labels

In the third column you can give the labels, you want Sankey Helper to show along with the inputs and outputs. Labels are optional and can contain numbers or text or both.  Check the formulas in the sample data sheet for a simple way to show labels with the names, current quantities and units (handy if you're about to change the data and don't want to retype labels in the data sheet all the time). In the diagram, labels will be contained in editable text boxes.

Advancing lines (draw code adv ) can have labels too. The text box will then be placed in the middle of the line. 

The text font and font size are definable in the macro sheet (see user definable variables in the top left corner of the macro). Standard is 14 point Arial. 

[image: image19.wmf][image: image20.wmf]
Handling the diagram

Once the diagram is drawn it will be presented as a group of graphical objects (lines, arcs, textboxes). This group will be selected. You can paste the diagram directly into a drawing program and work with it there. You can select the whole diagram by pointing the cursor over a line (the cursor will change to an arrow) and clicking once. Yu can also tweak the diagram in Excel: choose "Ungroup" from the "Format" menu in Excel, to ungroup the drawing to single elements of the drawing. Use the "Bring to Front" command in the same menu to bring labels to the front if necessary. Keep the drawing grouped however if you want to scale it manually. 

You can re-group the drawing by first selecting all graphic objects. Select one object and press Command + 'A' ([image: image21.wmf] + A) or choose "Select Special.../Objects" from the "Formula" menu. Then choose "Group" from the "Format" menu to re-group all the graphic objects.
How do I change the appearance of the arrows?

Standard Settings

There are basically two places that change the looks of the arrows. 

Firstly and most conveniently you can change the standard parameters in the macro sheet. You can find the standard parameters/user-definable variables in the top left corner of the macro sheet "Sankey Helper". If you can't see the window "Sankey Helper" after opening the macro, choose Unhide... from the Window menu.

These parameters will be used as standards. The meaning of the parameters are explained in the section below. You will need to re-draw the diagram for seeing changes to take effect. 

[image: image22.wmf]
User-definable parameters contained in the macro sheet "Sankey Helper"

Overrides for single fluxes

Secondly, you can override the standard parameters of the macro by putting user-specified parameters in the appropriate cell of the data sheet. This is only necessary if you want to change the way some of the items are drawn. 

For overrides the data table needs to be expanded in the following way:

1st column
2nd column
3rd column
4th column
5th column
6th column

draw code
measure
label text
tan(angle)
Overlap for arrows
radius ratio

compulsory
compulsory
optional
optional, 

Standard override
optional, Standard override
optional, Standard override

The function of the less obvious parameters 'tan(angle)', 'overlap' and 'radius ratio' are discussed in the following section:

 Standard Overrides
The following items in the data sheet are only necessary if you want to override the standard settings in the macro sheet for some fluxes (If you want to change all the fluxes in the same way it is easiest to change the standard settings in the macro sheet itself (and deleting the overrides in the data sheet), cf. above.

If you don't use them, the columns in the data sheet must be left blank, since Sankey Helper will look out for overrides anyway.
4th column: tan(angle)

Sankey Helper draws input fluxes as varyingly fat arrows with a head and tail wedge. 

tail wedge

[image: image23.wmf]
head wedge
The tan(angle)-column overrides the standard angle setting (i.e. the tangens of the angle) of the wedges. For input arrows this is the tail edge. For output arrows its the head wedge. Big values give spikier wedges. An value between 0.1 = tan(6°) and 0.5 = tan(27°) is recommended. 

Alternatively you can set tan(angle) to zero, resulting in flat heads or tails. 

       [image: image24.wmf]    [image: image25.wmf]   [image: image26.wmf]    [image: image27.wmf]  

5th column: Overlap for arrows

As you see in the above examples, arrow heads can be draw with or without overlapping head wedges. The overlap is defined relative to the width of the arrow. An overlap of 0.1 will give you arrow heads with 120% of the width of the flux (10% overlap on each side). Reasonable values are between 0 and 0.5. An overlap will put an emphasis on the outputs of the diagram. Too much overlap will distort the visual impression of Sankey diagrams and hence diminish its purpose.

6th column: radius ratio

Sankey Helper draws bent arrows. There are many ways to do this. Sankey Helper is restricted to drawing 90° turns in arrows, but you can choose freely the "roundness" of the arrows. The radius ratio gives the radius of the inner arc relative to the width of the flux. Big values will give you more spacious diagrams, small values will result in more condensed and compact diagrams.

[image: image28.wmf]   [image: image29.wmf]   [image: image30.wmf]
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0

radius ratio

See the effects of changing the radius ratio.

 Here's a diagram with a standard radius ratio of 0.3:


Here the same data drawn with a standard radius ratio of 2:

(after some scaling)
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[image: image32.wmf]

Note that the relative widths of the corresponding fluxes are equal. Nevertheless the diagram on the left gives a much more dense impression.

For the starting line, any value entered in the 6th column will be interpreted as override scaling factor.

Overrides and where they make sense

Please, note that you need to reserve a six-column space for the data table in any case. Figures not related to the Sankey diagram shouldn't be within this range. But of course not all the override variables make sense for all the draw codes. This is displayed in the next table.

Sankey Helper will look up all the cells marked  '•' to draw the corresponding draw code. The contents of the cells marked '-' are ignored.

1st column
2nd column
3rd column
4th column
5th column
6th column

draw code
measure
label text
tan(angle)
Overlap for arrows
radius ratio

start
•
•
•
-

• *

in
•
•
•
-
•

out
•
•
•
•
•

adv
•
•
-
-
-

leftend
-
-
-
-
-

in
•
•
•
-
•

out
•
•
•
•
•

adv
•
•
-
-
-

rightend
-
-
-
-
-

end
(•)
•
•
•
-

*
In the starting row the value 6th column defines an optional override for the scaling factor (see chapter below)

User-definable variables

In the top left corner of the macro sheet "Sankey Helper" you will find various variables, that will be used to draw the diagram. You can change these variables to influence the way the appearance of the diagram.

Starting coordinate x and y: This is the starting point from where the diagram is drawn starting at the right side of the top input arrow . Sankey Helper draws the diagram first on the data sheet itself and then transfers it to a new worksheet. If the diagram bumps into the borders of the sheet, it will be cut off there. Set big enough offsets here, so that the whole diagam can be drawn, especially if you are using big scaling factors. The X-axis is from left to right; the Y-axis from top to bottom.

Scaling factor (zoom): This is an overall magnification factor for the whole diagram. For optimal results choose a factor that the smallest item won't be smaller than 10 points (flux times scaling factor). The scaling factor doesn't apply to the font size of the labels. Change that separately in the font size parameter (cf. below). 
You have the possibility to type an override scaling factor in the data sheet: In the first row (start) in the 6th column enter the desired scaling factor. The advantage is that you store the scaling factor with the data an do not need to change the scaling factor manually when drawing diagrams with dissimilar flux sizes.

tan(angle), overlap, radius ratio: These three variables are the Standard variables for how to draw arrows in the diagram. Their meaning is explained in the Standard overrides section above.

Font and font size for labels: enter the font name and font size (in points) for labels here. 

Some Standard Designs

0.18
tan(angle) 

0.2
overlap

0.3
radius ratio 
0.18
tan(angle) 

0
overlap

0.3
radius ratio 
0.18
tan(angle) *

0
overlap

0.3
radius ratio 

*
and an override of zero for all inputs

[image: image33.wmf]
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0.6
tan(angle) *

0
overlap

0.3
radius ratio 

*
and an override of 0.2 for all inputs
0.6
tan(angle) *

0.5
overlap

0.3
radius ratio

*
and an override of 0.2 for all inputs
0.6
tan(angle) *

0
overlap

2
radius ratio

*
and an override of zero for all inputs
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[image: image38.wmf]

0.18
tan(angle) 

0.2
overlap

0.3
radius ratio *

*
and an override of 2 for all inputs
0.18
tan(angle) 

0
overlap

0.3
radius ratio *

*
and an override of 2 for all outputs
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Troubleshooting

• 
If I change the figures in the data sheet , the diagram doesn't change accordingly.

Yes. Sankey Helper is a command macro that draws static pictures according to the data sheet. Unlike an MSExcel chart there is no dynamic linkage between the data and the drawing once the drawing is finished. You will need to re-run the macro to get a new, updated diagram.

• 
I'm getting very strange and disproportionate drawings although all the data seems correct. 

Be sure to have a total of six columns reserved for the data table. You might only be using the first two for the draw codes and the measures, but Sankey Helper will be looking in the other four columns for optional layout parameters, which influence the way the diagram is drawn. You don't necessarily need to bother with these. Just make sure you leave four additional empty columns at the right hand side of your data table. Also only use positive, and not negative measures in the data table.

[image: image41.wmf]


"when diagrams mutate... "

• 
I'm getting irregular arrowheads and badly drawn lines in my diagram.

This can happen, if you try to draw small quantities i.e. < 1. Try to increase the scaling factor of the drawing in the macro sheet, cf. user-definable variables in the top left corner (or alternatively in the 6th column of the first data line). The scaling factor is an overall magnification factor for the diagram. The product of the scaling factor and the smallest flux you want to draw should be about 10 for good resolution. The reason for this is that MSExcel lines and arcs can only be drawn with integer coordinates. All differences below 1 are disregarded and therefore distort small items.

• 
"Sankey Helper" takes all my graphic objects out of my data sheet and puts them together with the diagram on the newly created worksheet.

Yes. Sankey Helper actually draws the diagram on the data sheet first and then pastes it onto a new worksheet. All graphical objects on the data sheet are grouped and moved together with the finished diagram. There is currently no solution to this other than not to use any graphic objects on the data sheet. Sorry!

• 
Can I draw filled arrows?

No. The diagrams are only a bunch of lines grouped together. Excel won't recognise the area within as such. If you absolutely need to have filled fluxes, then I suggest you paste the diagram into a bitmap-oriented drawing program (like Photoshop) and apply fill colours manually:
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Diagram after 
some painting 
in Photoshop 
(bitmap picture)

Legalese
Copyright, Conditions of Use and Distribution
Sankey Helper is copyright © 1998–2003 by Gabor Doka 

Sankey Helper is provided free of charge. However I am interested to see, what is done with Sankey Helper. So send me any nice PICTs (or GIFs, JPEGs et cetera) you created with the help of Sankey Helper (send to doka@unite.ch). They are welcome and enthusiastically applauded.

Sankey Helper may be distributed freely provided that all the macro, documentation and sample data are always distributed together, in whole and unchanged. Sankey Helper may not be sold or offered for sale, or included with another software product offered for sale. Companies that distribute public domain/freeware/shareware software for profit are expressly prohibited from distributing Sankey Helper. 
Disclaimer
The author assumes no responsibility for errors in this program or its use, or for any direct or consequential damages. There shouldn't be any serious bugs anyway.

